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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave 
 

A reader needs help utilizing the "print-to-file" option; how do you know if a 
downloaded utility is from a reliable source?; a reader wants to convert music 
files to the .wav format.

 

 
Dear Digital Dave, 
 
Thanks for the many years of useful advice and techno magic. I think you're a genius and I hope 
you can answer this fairly simple question.  
 
I have a greeting card program that lets you create greeting cards and other projects and attach 
music and so on (pretty nifty, huh?). Well, the program has an option to let me attach my own 
music as long as it is a .wav format. The manufacturer's site tells me Windows Media Player 
saves audio music in this format, but the songs are actually saved in the .wma format. I also 
have many songs on iTunes that are in yet another format.  
 
Is there a way to convert my music so I can save .wav files and use them with my greeting card 
program? 
 
Tami W. 
San Diego, CA 
 
Dear Tami, 
 
I believe there may have been a time when Windows Media Player would save in alternative 
formats other than Windows Media (WMV, WMA, etc.). However, while many formats can be 
played, you will want a third-party application to convert your files to the WAV format. 
Fortunately, there are plenty of them around, plus most will handle many more formats. With a 
quick search I located FreeRip MP (download.cnet.com/FreeRip-MP3/3000-2140_4-10050140.
html?tag=mncol;pop) and Koyote Free Mp3 Wma Converter (download.cnet.com/Koyote-Free-
Mp3-Wma-Converter/3000-2140_4-10442362.html). I'm sure that there are many others. 
Perhaps people will offer their favorites by clicking on "Comment on This Digital Dave Column!" 
at the top or bottom of this column. 
 
Digital Dave 

Dear Digital Dave 
 
I have a Canon 190 printer and I am using a Toshiba satellite laptop with 32-bit Windows Vista. I 
would like to know how to print to file. The print to file option is grayed out. I want to print to file 

ComputorEdge 9/10/10

3 of 42



some knitting and crocheting patterns available online from a newsletter, without copying and 
pasting. Is this possible? 
 
Glenda 
San Marcos, CA 
 
Dear Glenda, 
 
Of course there are a number of ways to print to a file rather than paper. Which technique you 
want to use depends upon how you want to use the file. 
 
When you "Print to File," you are actually creating a file with the drivers for the selected printer, 
including all the print codes for that printer. If the file is later sent directly to the printer, then it will 
print as if you were directly printing the selected page. If your plan is to view the file with a word 
processor or other application, it is unlikely that the file will be readable—especially if there are 
graphics in it. 
 
If it is the print file you want to save, then you can enable the "Print to File" in Internet Explorer 
by turning off the Protected Mode (restart of IE required). When you load IE, you may need to 
"Run as administrator" (right-click on shortcut and select). 
 
However, if your plan is indeed to later view, e-mail and/or print pages saved on your computer, 
then you want a standard format that will be flexible enough for all these things. This is why the 
PDF (Portable Document Format) was designed. You can pick up a copy of CutePDF or any 
one of a number of other programs. (Last year, Michael Ross authored an extensive review of 
PDF-creation programs. Pay particular attention to the comments and recommendations from 
readers at the end of the article.) Once the program is installed on your computer, an option to 
create a PDF will appear in the Print dialog box as one of your printers. 
 
The advantage of creating a PDF is that it will include all graphics and text, while you can view it 
in any PDF reader (Adobe Reader) as well as print and e-mail. 
 
Another alternative is to use "Save as..." in the File menu of most browsers to save the page as 
HTML code, which you can later load into your Web browser of choice. 
 
Digital Dave 

Dear Digital Dave, 
 
I am hesitant to use the so-called "clean-up" utilities because I am concerned about 
inadvertently inviting a virus in. What do such utilities do, and how can I verify the designer is 
competent? 
 
Bruce Osterberg 
Temecula, CA 
 
Dear Bruce, 
 
This is an excellent question. I have the same concerns about checking out any new software. 
There are so many programs out there that it's not always easy to know if it's from a reliable 
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source. 
 
I rarely download software directly from the originator's site. I want to know what others are 
saying about the program and how many people have tried it before me. This is why I will go to 
a Web site such as CNET's download.com (download.cnet.com) when looking for free (or any) 
software utilities. There are a number of advantages to going to a reputable source for 
downloads. 
 
First, most of the programs are tested "spyware free" before they get listed. But even more 
important, the best programs have been downloaded and installed millions of times. That means 
all those millions of people have been guinea pigs for you. If there were problems with the 
software, it would show up in the user ratings—that's if complaints haven't already had the 
program removed from the download section. 
 
As a bonus, many of the programs have been reviewed by the CNET editors. I look for these, 
although I put more weight on the comments and ratings from users that will give insight missed 
by the editors. If a program gets good user rating and has high download activity, then I 
consider the program reasonably safe. 
 
CNET will also explain in some detail what each program will do. Often very different utilities 
may fall in the same category. Read the description before you download something that won't 
help you with your problem. 
 
Digital Dave 
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Computer Forensics
“Forensic data recovery can be a costly and time-consuming process.” by Pete Choppin 
 

The science of computer forensics deals with the legal concerns of data that can be critical to the survival of a 
company. Forensic data recovery is the only way to ensure that any information gained through the recovery 
process will hold up in a court of law.

 
 
Most of the time, computer problems are relatively minor—at the worst, hard drive crashes result in lost 
data, including pictures, spreadsheets and all-important client databases. Sometimes, though, data loss is 
more important.  
 
To an individual user, perhaps, the loss of pictures and spreadsheets can be a serious problem. However, 
the science of computer forensics deals with the legal concerns of data that can be critical to the survival of 
a company.  
 
In IT, we are talking about protecting the interests of the company, and it can involve litigation and 
criminal trials. If you find yourself needing forensic data recovery, it can be a costly and time-consuming 
process.  
 
Why Use Forensics 
 
Forensic data recovery isn't for everyone, obviously. If your home or business drive crashes and you need 
the data back without reconstructing it, a normal data-recovery service is by all means precisely what you 
need. Your IT department may even be able to recover that data without having to use outside sources.  
 
If, however, you need to preserve the integrity of the data for legal reasons, or if you need to find out if a 
drive has been illegitimately tampered with, forensic data recovery is the only way to ensure that any 
information gained through the recovery process will hold up in a court of law. A knowledgeable lawyer 
will cut down any evidence presented without a full chain of custody report, and you may even need an 
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expert witness to testify. The goal of computer forensics is to perform a structured investigation while 
maintaining a documented chain of evidence to find out exactly what happened on a computer and who 
was responsible for it.  
 
Case in Point 
 

A perfect example of computer forensics happened where I work. A former 
employee, who left on not-so-happy circumstances, began making threats about 
handing over proprietary information to another competing company. Because 
there was a non-compete contract in place, which he signed during his 
employment, this would mean he was breaching the contract and there was legal 
cause to not only prevent him from sharing the information to another company, 
but also to begin an investigation of the data to which he had access.  
 

If we used our standard data recovery, the information we could retrieve would not be enough to stand up 
in court. By using e-discovery and systematically using computer forensics, the evidence was complete 
with a chain of custody and an explanation of what had to be done to retrieve the data. We were able to 
build a much stronger case. Even if the data isn't recoverable, a forensic data-recovery lab can prove that 
our employee purposely destroyed his e-mail, which is enough to end a case in many situations.  
 
E-Discovery 
 

E-Discovery refers to a legal process of finding or discovering information that 
is only available electronically. Electronic information is different from paper 
information because of its intangible form. Also, electronic information is 

usually accompanied by metadata, which is not present in paper documents, but plays an important part as 
evidence in litigation.  
 
Examples of the types of data included in e-discovery are e-mail, instant messaging chats, documents, 
accounting databases, CAD/CAM files, Web sites, and any other electronically stored information that 
could be relevant evidence in a lawsuit.  
 
How Does It Work 
 

Most of the time, forensics cases don't involve physically damaged drives, but 
rather drives with deleted files or the like. The forensics company will make a 
clone of the drive, and then work on that clone for the remainder of the process; 
this ensures that there is no chance of losing any information from your original 
drive. Using a large number of programs, the company will analyze key files 
created by the operating system to reconstruct what a person used the computer 
to do.  

 
Forensics experts can also undelete files in many situations if the hard drive used Windows formatting, 
retrieving key pieces of evidence such as e-mails or Microsoft Office documents. This is because files 
deleted in Windows aren't actually destroyed; the operating system merely marks these files as deleted and 
allows them to be overwritten. Other operating systems, in contrast, may overwrite the files immediately 
when the user selects them for deletion. Once a file has been overwritten, it is usually irretrievable, but 
since most users don't realize what needs to be done to permanently destroy a file, it is fairly common for 
files deleted in Windows to be retrieved unscathed.  

ComputorEdge 9/10/10

7 of 42

http://./
http://./
http://./


 
In the case of e-discovery there are some rules about compliance, and evidence should be gathered as 
quickly as possible. With electronic message archiving in place for both e-mail and IM, it becomes a fairly 
simple task to retrieve any e-mail or IM chat that might be used in e-discovery. Some archiving systems 
apply a unique code to each archived message or chat to establish authenticity. The systems prevent 
alterations to original messages, messages cannot be deleted, and the messages cannot be accessed by 
unauthorized persons. Modern message-archival systems allow legal and technology professionals to store 
and retrieve electronic messages efficiently and in a timely manner.  
 
It may seem easy to delete files or e-mails, but with the use of expert forensics it is extremely hard to beat a 
computer forensics company at their own game.  
 
Protecting Yourself  
 

I am not talking about covering your tracks when you are guilty of a crime. 
Once an investigation begins and the forensic evidence is being gathered, 
anyone can become a suspect. Computer data does not care whether or not you 
are guilty.  
 
Because I was involved in the IT side of an investigation, I learned a few things 
in the process. I am much more aware of how and with whom data is transferred 

both within and outside of our network. Keep in mind the following:  
 
1. Avoid personal correspondence using company e-mail. If you need to communicate with friends and 
family outside the organization, use a personal e-mail account that is Web-based if possible.  
 
2. Never place company files on a personal laptop or computer. In fact, avoid taking files offsite if at all 
possible.  
 
3. Be very conscientious of your communication. You may, without knowing it, share proprietary 
information over messengers or e-mail. This can be used against you in an investigation.  
 
4. If you have signed a non-compete or nondisclosure contract with the company you work for, you are 
under legal contract not to share company secrets or information with anyone outside the company. 
Usually this extends for a specific period of time after you leave the company.  
 
Even if you did not commit any crime or knowingly share information, you could be guilty by association 
or as an accomplice if evidence is found that information related to the investigation passed through you in 
any way.
 

Pete Choppin has been an IT Professional for over 15 years. He currently works as a network and systems 
administrator for a company called Albion based in Clearfield, Utah. He has experience in all types of 
hardware, software, and networking technologies. He is proficient in many operating systems including 
Linux, Windows and Macintosh. His interests include cooking, sci-fi, computers and technology, and Web 
design—a semi-professional endeavor, having designed Web sites in the dental field, e-commerce 
businesses, and for the Boy Scouts of America.  
 
Pete has been a devout reader of ComputorEdge since 1990 and contributes regularly to featured articles as 
well as the Linux Lessons section of ComputorEdge. He can be contacted at pchoppin@comcast.net but 
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prefers to have comments on ComputorEdge articles submitted to the editor and posted for the benefit of 
all readers. 
 

ComputorEdge 9/10/10

9 of 42



Return to Table of Contents

Who's Got Your Back?
“We rely on our digital lives more than ever, but are we keeping our data safe?” by James Hartnett 
 

Backing up your computer isn't a very exciting chore, but with our increased dependence on digital technology, 
can we afford not to? The best backup options are simple and easy.

 
 
We are putting more and more important data on our electronics, but are we taking more and more care 
that our data is safe? 
 
Backing up your computer storage, like flossing your teeth, sending thank-you cards, or changing the filter 
in the furnace, is one of those important activities honored more often in the breech than the observance. 
It's just not very exciting—it's a chore. And this chore has been with us from the earliest days of computing. 
 
Back in the Olden Times 
 
One of my University computer jobs involved the backing up of the data on what was then called a mini-
computer. These were between the toy-like micro-computers of the day, and the equally toy-like (but much 
more expensive) mainframe computers of the day. 
 
The mini-computer looked like a mainframe—a bunch of refrigerator-sized chassis in the refrigerator-
temperature computer room. (It was always lovely to go in there on a hot summer day!) To back it up I had 
to load reels of magnetic tape on to the front of the machine, enter a command at the console, and go back 
to doing my math homework while the computer wrote data to tape after tape. 
 
The consequences of a mistake could be severe—I was hired for the job after the previous incumbent was 
ignominiously fired. The disk failed, and it was found that he had not been making proper backups for 
weeks. As a result, weeks of scientific work had been lost. 
 
Sometimes the Old Ways are the Good Ways 
 
In the years since then, computational hardware has advanced at a dizzying pace. The giant set of disks 
(which I spent so much time backing up) were a massive 300MB. Today I have a half-dozen data sticks 
much larger than that, just kicking around my desktop and briefcases. They give them away at conferences 
and trade shows. 
 

But the need for backups has not changed, 
because people have not changed. Our 
hardware is more reliable, but we are not. 
One of the largest causes of lost data is 
human error. Someone deletes something 
that they shouldn't. And even our vastly 
increased hardware reliability is not going to 
compensate for the fact that we now carry 
our computers everywhere. 
 
My old mini-computer had disks that would 
crash if you looked at them the wrong way. 
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My most recent computer, Yum-yum the 
Eee PC netbook, doesn't even have a disk 
drive—it's all flash memory. I can drop it on 
concrete and it would still work. But unlike 
my old mini-computer, which sat in a secure 
building, Yum-yum comes with me 

everywhere. It's less likely to break, but far more likely to get lost or stolen. 
 
Backing up my data is more important than ever—but I have even less time available than that harried 
student I was in my youth. How can I have the backups without the tedium? As with so many questions 
these days, the answer is the Internet. 
 
Sometimes the New Ways are Better Ways 
 
These days, we don't back up to tape any more. We demand near-instant retrieval of our backed-up data, 
which is hard for tape systems to manage. We also benefit from super-cheap, super-dense disk technology. 
It's easier and cheaper to back up data to a disk server than it is to back it up on tape. 
 
Most of us, though, don't have any disk servers running in our garage, and this is where the Internet comes 
in. Why should I run a disk server when there are so many people out there who can do so more reliably 
than I can? And most of us need to back up only a trifling amount of data anyway. Disk servers are most 
economical in the terabyte range, and I would be lucky to have a gigabyte of data to back up, a mere one-
thousandth of the capacity of even the lamest disk server. 
 
Hence the rise of companies like Mozy, the online backup people. For about $5 a month, you can have 
your PC backed up over the Internet, onto Mozy servers. If you ever need any of your old files, they will 
be right there for you. Businesses have to pay more but, if your business is data-centric, the cost is trivial 
compared to the benefits. Your data is backed up remotely and safely, with very little investment of your 
time. 
 
What You Must Still Do 
 
Although you don't have to sit in front of tape drives waiting, there is still one task that you must pay 
attention to: specifying what to back up.  
 
Most of the stuff on your hard drive is not worth backing up, because most of it is software, installed from 
disc or over the network with complex installations programs. These days, software is rarely just a single 
executable file. Backing up these files makes no sense, since you usually cannot restore them in a useful 
way. When these programs get messed up, you reinstall from the disc or over the network, the same way 
you originally installed the program. 
 
The only files that need to be backed up are the personal files that you have added to the computer: your 
documents, pictures, music and videos. In the Windows world, these are all usually kept under a folder 
called My Documents. In the Linux world, these will be under your home directory.  
 
When setting up a backup, make sure that all the data you want to back up can be written to some directory 
under My Documents, and if not, make sure that you add the appropriate directory to the list of what is 
backed up. 
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Cheap, or Just Frugal? 
 
For those of us who don't have a data-centric business, but only the usual data-centric lives, is there a 
solution that is even cheaper? Of course there is, and it is called Google. 
 
My data-centric life has involved many a lost computer file, and much wailing and gnashing of teeth as a 
result. When Google Docs came out I saw the immediate benefit of having someone else manage all my 
data files. For me, Google has it all. 
 
These days, Google will even let you store any old data file on its servers, up to a gigabyte for free. Well, 
that's very nice. By using Google Docs for spreadsheets, word processing and presentations; using 
Google's Picasa and You Tube for photos and videos; and the extra Google gigabyte for everything else, 
the enterprising computer user can get very nice online backups for free! 
 
Privacy? Who Cares! 
 
This solution sacrifices all notions of privacy to Google. Can they make any use of all these documents? I 
really don't know—but I note that they are very good at extracting information from large numbers of 
documents. 
 
In my case, I can't see that it matters. Mostly what Google will find, looking at my large collection of 
online documents, will be a lot of articles for ComputorEdge. Since they are intended for publication 
anyway, I really don't mind if Google looks at them. Or, for that matter, my work documents, none of 
which involve anything secret. 
 
If I did care more about my privacy, I could encrypt my data before sending it to Google, and be 
reasonably confident that no one outside the National Security Agency could read it. And if anyone at 
Google is reading this, how about some more storage? One gigabyte isn't much! 
 

*                    *                    *
 
Editor's Note: If for some reason all of your backup plans have gone awry, or you accidentally delete files 
you need, then you may want to check out software for recovering data (download.cnet.com/1770-20_4-0.
html?query=data+recovery+software&searchtype=downloads&rpp=10&filter=licenseName=Free|
platform=Windows,Webware|&filterName=licenseName=Free|platform=Windows,Webware|&tag=ltcol).
 

James is a writer and software developer who has been with the free software movement from the 
beginning. He lives, writes, and programs in sunny Colorado.
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Windows 7 Tips and 
Tricks
“Restoring the old Windows 
XP/Vista right-click menu.” 
by Jack Dunning 
 

In the Windows 7 Taskbar, it's 
not as easy to restore, 
maximize or minimize all of 
the windows under the tab 
when there are multiple copies 
running. Here's how to restore 
Vista and XP's old right-click 
menu.

 
 
This week is a really quick tip for Windows 7 users. One of my complaints about the new Windows 7 
Taskbar was that it was no longer easy to restore, maximize or minimize all of the windows under the tab 
when there are multiple copies running. Every time I would right-click on an application icon/quick-launch 
button, I would get a jump list, as shown in Figure 1. (Looking at Figure 1, it's obvious that I'm not the 
only one using this computer.) 
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Figure 1. In Windows 7, the jump list is displayed when right-clicking on a taskbar program tab.

 
 
With a little digging around, I finally learned that the old Windows XP/Vista right-click menu can be 
restored by holding down CTRL+SHIFT when right-clicking (see Figure 2). 
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Figure 2. The traditional menu will be displayed when the right-click is accompanied by holding down CTRL

+SHIFT.
 
 
This may be helpful to many Windows 7 users who have been frustrated by the changes, although if you 
right-click the individual thumbnails that appear when you hover over a tab, you will get the old familiar 
menu for that open window (see Figure 3). 
 

 
Figure 3. The jump list is displayed when right-clicking on a taskbar program tab.

 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 
1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached 
at ceeditor@computoredge.com
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Wally Wang's Apple Farm
“Data Recovery on the Mac” by Wally Wang 
 

Time Machine, Apple's built-in backup program, and Data 
Rescue 3 are solutions to help you protect your Mac's data. 
Also, the iPad finds even more uses; more about Flash running 
(or not running) on mobile phones; Apple reveals new iPods 
and more; designing Web pages with REALStudio; and a tip 
on using the View menu to modify the appearance of iTunes 
10.

 

 
The first accessory every Macintosh user should get is an external hard disk. By plugging in an external 
hard disk, you'll be able to use Time Machine, the built-in backup program that comes with every Mac.  
 
As you use your Mac, Time Machine captures snapshots of your entire hard disk. Now if you accidentally 
delete a file, you can just load up Time Machine, view your computer on a specific date in the past, and 
find the file exactly as it once existed on that day. Copy that file and you'll have recovered any file you 
accidentally deleted or modified by mistake. Time Machine makes backups simple, fun, easy and painless. 
In comparison, most other backup solutions make you go through so many steps that it's easy just to forget 
about it until it's too late. 
 
If you don't have an external hard disk with Time Machine protecting your data, there's another solution 
called Data Rescue 3 (www.amazon.com/gp/product/B002RSFNVE?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=B002RSFNVE). If you're familiar with 
The Norton Utilities from the PC world, Data Rescue 3 works the same way. 
 
When computers delete a file, they simply delete the directory listing to that file, but not the actual file 
itself. As long as you don't add any new files or modify any of your existing files, your deleted file's 
contents remain. To retrieve a previously deleted file, you use a program like Data Rescue 3, which can 
boot up from its disc to avoid modifying your hard disk.  
 
From the safety of the disc, Data Rescue 3 can scan your hard disk and identify files that you can retrieve. 
If you recently deleted a file, Data Rescue 3 can retrieve it with 100 percent accuracy. However, the more 
you use your computer after deleting a file, the lower the chances of recovering a previously deleted file 
completely, although Data Rescue 3 can often recover large portions of such files anyway. 
 
Data Rescue 3 isn't the type of program you'll think about buying right away, but you should. The moment 
you delete a file by mistake and don't have any backups to retrieve it from, you'll need to use a program 
like Data Rescue 3 right away. The program's easy to use with a simple user interface, so you won't need 
any technical knowledge to run it.  
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Data Rescue 3 can't guarantee it will recover every file you delete by mistake, but chances are good it can 
recover most of them. You may never need Data Rescue 3, but when you do need it, you'll be happy you 
had it around. 
 
More Uses for the iPad 
 
To keep up with demand for the iPad, Apple has increased production to two million iPads a month 
(digitaldaily.allthingsd.com/20100903/apple-building-2-million-ipads-per-month-but-shooting-for-3-
million/?mod=tweet) and eventually hopes to reach three million iPads a month. Pretty soon you'll be able 
to walk into your favorite store and pick up the iPad model that you want without waiting for it to be 
delivered several days later. 
 
Doctors, lawyers and business people are adopting the iPad due to its light weight, small size, big screen 
and ability to view word processor documents, spreadsheets, presentations and Web sites (www.reuters.
com/article/idUS345583965620100830?loomia_ow=t0:s0:a49:g43:r3:c0.096357:b36947576:z0). Ted 
Schadler, an analyst at Forester Research, said, "iPads are a tremendously empowering technology that any 
employee can buy." 
 
A school in Scotland has given its students iPads as a learning tool (www.dailyrecord.co.uk/news/scottish-
news/2010/08/31/scottish-school-becomes-first-in-world-where-all-lessons-take-place-using-computers-
86908-22525988/).  
 
IT teacher Fraser Speirs said, "We began exploring the different options earlier this year and when the iPad 
was released we decided that this solved all of the problems we had. 
 
"Each of the children will have their own iPad, which is hooked into the school's wireless network and 
from there they will use the computers for learning in different subjects. 
 
"They will obviously be able to use the Internet for research, but we've found that it solves major problems 
for us—especially in science subjects as now they can watch experiments that would be too dangerous to 
do in class on YouTube." 
 
Lloyd's of London is even testing iPads as a replacement for leather briefcases jammed full of paper forms 
(www.ft.com/cms/s/0/7ea2a148-b793-11df-8ef6-00144feabdc0.html). Sue Langley, Lloyd's director of 
market operations, said, "By simply replacing the paper with something easier to carry, but which allows 
amendments and links to other services, we continue to support the underwriting and face-to-face 
negotiation that makes Lloyd's unique." 
 
The iPad may not be for everyone, but clearly enough people find the iPad useful in ways that could never 
be duplicated by lugging around a laptop computer or even a netbook. More importantly, the iPad isn't 
hurting sales of the Macintosh (techcrunch.com/2010/07/21/ipad-sales-mac/). In fact, Apple keeps selling 
more Macintosh computers along with iPads, which indicates that people find that the iPad and the Mac 
are both useful in different ways.  
 
More Flash News on Android 
 
Despite all the hype about running Flash on Android phones, there's been shockingly little information 
about how well Flash performs. If Flash ran exactly as well on mobile phones as it does on computers, 
you'd think Adobe would be boldly proclaiming this feature to everyone by now. Someone finally tested 
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Flash on a Nexus One and posted a video of Flash running (newteevee.com/2010/08/31/video-flash-on-
android-is-startlingly-bad/)—and found that the results were less than impressive. 
 
Here's the general problem. Flash works fine on regular computers but only works on mobile phones where 
visiting sites specifically optimize their Flash content for mobile devices. If you're expecting Flash to work 
identically on your mobile phone as it does on a computer, you're going to be disappointed when you run 
into unresponsive sites or choppy Flash content.  
 
For people using Android phones, viewing Flash content will be unpredictable. Sometimes Flash will work 
and sometimes it won't. If you don't mind this unpredictable behavior and can accept Flash's limitations, 
then Flash and Android may be for you.  
 
For the average person who expects Flash to work all the time like it does on a regular computer, this 
unpredictable experience with Flash will likely lead to confusion and frustration. They may not know if 
their phone is suddenly not working, their Internet connection is faulty, or Android is acting up. These 
people will likely blame their phone manufacturer and not Adobe for their Flash problems. Adobe is the 
culprit, but everyone else will get the blame. 
 
Just be aware that future Android phones may advertise Flash as a competitive advantage over the iPhone. 
As long as you're willing to accept a less-than-perfect Flash experience on Android, then Flash may be a 
selling point for Android. Otherwise, don't be fooled into thinking that any mobile phone without Flash is 
inherently inferior. 
 
Remember, anti-Apple critics once claimed that the iPhone was inferior because it lacked Flash, while 
these same critics ignored the fact that every other mobile phone in the world also lacked Flash.  
 
Now many of these same anti-Apple critics will claim that the iPhone is inferior to Android phones 
because only Android has Flash. What these critics won't tell you is that Flash on Android won't be what 
you might expect. This would be like an airplane salesman telling you that a Sopwith Camel can fly just as 
fast as a 747 jumbo jet (while ignoring the fact that if a Sopwith Camel flies that fast, its wings will tear 
off, but it can still fly as fast as a 747 at least once).  
 
Don't blame Google's Android and don't blame your phone manufacturer. Pin the blame on Adobe. Flash 
may never be capable of running on mobile devices as seamlessly as we would all like, so perhaps it's time 
for everyone to let go of any illusions about Flash and embrace other alternatives for the future, such as 
HTML5. 
 
To see what a Web site can look like running HTML5 (instead of Flash), visit Apple's Showtimes (trailers.
apple.com/trailers/showtimes/) page to help you find a movie playing near you.  
 
The Latest Apple News 
 
On September 1, Apple held its annual media event where it announces new iPods. With the iPhone and 
iPad growing in popularity and including the ability to play music like an iPod, the days of the iPod may 
seem numbered. However, Apple did release several new iPod models for people who just want a portable 
music player. 
 
First, there's the $49 iPod Shuffle, which is geared for anyone who wants a small and light digital music 
player for listening to music wherever they go, such as while working out in a gym or jogging. 
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Figure 1. The iPod shuffle is the smallest iPod available.

 
 
Next, there's the $149 iPod Nano, which abandons the traditional click-wheel interface and provides a tiny 
touchscreen interface like the iPhone. Like the iPod Shuffle, the iPod Nano also includes a built-in clip so 
you can attach it to your shirt or pants while you do something else, such as riding a bicycle or walking 
around. 
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Figure 2. The iPod Nano offers a touchscreen interface.

 
 
Finally, there's the $229 iPod Touch, which acts like an iPhone without the phone. Just like the iPhone, you 
can download and install apps. With its built-in cameras, the iPod Touch also lets you do video 
conferencing through FaceTime so you can chat with anyone with an iPhone or iPod Touch through a Wi-
Fi connection. 
 
The iPod Touch also includes GameCenter, which lets you play online games against other people around 
the world. Gaming on the iPod Touch and iPhone has gotten so popular that even Sony and Nintendo are 
seeing sales of their portable game consoles plummet.  
 
At Apple's media event, Mike Capp from Epic Games showed a demo of a new medieval role-playing 
game called The Citadel running on an iPod Touch. The graphics quality of the game looked as good as 
video games running on dedicated game consoles. 
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Figure 3. The graphics quality of the latest iOS games rivals regular computer games.

 
 
Apple also dropped the price of AppleTV from $229 to $99. The idea is that you hook this up to your TV 
and through your Internet connection, you can rent movies and TV shows. Although video streaming is the 
future (kiss the cable companies good-bye), AppleTV still remains an interesting idea, but definitely not a 
must-have device.  
 
Curiously, Apple also released a new version of iTunes 10. Besides adding a social network feature dubbed 
Ping, which lets people share their thoughts about music, iTunes 10 also modified the user interface. 
 
Instead of displaying the traditional stoplight buttons (for closing, hiding, or expanding a window) 
horizontally, iTunes displays them vertically. If you have five or more songs from the same album, iTunes 
10 can now display the album artwork next to those songs. 
 

ComputorEdge 9/10/10

21 of 42



 
Figure 4. iTunes 10 offers a revised user interface.

 
 
After its annual fall media event, Apple rarely releases anything new until after the holiday season. If 
you're willing to wait until the beginning of next year, you can expect to find less expensive and even 
lighter MacBook Airs with a smaller (11.3-inch) screen, a new version of XServe, new versions of the 
MacBook and MacBook Pro, and updated versions of iLife and iWork.  
 
By November, Apple will release a new 4.2 version of its iOS operating system that will bring wireless 
printing to the iPad, iPhone and iPod Touch. The iPad will also gain the iPhone's ability to organize apps 
into folders. Of course, the next version of the iPad should arrive early next year as well, which should 
have dual cameras to allow FaceTime videoconferencing with an iPhone or iPod Touch.  
 
Designing Web Pages with REALStudio 
 
REAL Software makes REALStudio, formerly known as REALBasic. If you're familiar with Visual Basic, 
you can learn REALStudio in about 10 seconds because it uses the same type of drag-and-drop user 
interface design along with a BASIC dialect that's surprisingly close to the original Visual Basic 6 
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language (not the new Visual Basic.NET language).  
 
In the past, the primary advantages of REALStudio were its ease in letting you create a program and its 
ability to create a Windows, Linux, or Mac OS X program simultaneously. Just create the program once, 
compile and you have a program you can sell to three different markets. 
 
Starting this fall, REALStudio is going to offer a Web edition (www.realsoftware.com/web/), which will let 
you create entire Web sites using the familiar drag-and-drop interface of Visual Basic. The idea behind this 
Web edition of REALStudio is to let you create interactive Web pages without having to learn HTML, 
PHP, or JavaScript. 
 
Besides letting you design interactive Web pages easily, REALStudio can also compile your files into 
binary or machine code. Unlike most Web sites that consist of separate HTML, PHP, or JavaScript files 
that can be modified by others (including a hacker), a REALStudio Web site is compiled into machine 
code, making it extremely difficult to modify while also letting your Web pages run as fast as possible. 
 
Best of all, any Web pages you create using REALStudio can be viewed through any browser, so users 
don't need to download and install yet another plug-in. If REAL Software can deliver on its promises, 
REALStudio just may make Web page programming fun, easy, fast, and more powerful than ever before. 
 

*                    *                    *
 
By default, iTunes 10 displays your songs in something called Album List view, which means if you have 
five or more songs from a single album, iTunes 10 will display that album on the left side of the iTunes 
window. In case you don't like this, just choose View/List (or choose any other option under the View 
menu) to change the way iTunes 10 displays your music. 
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Figure 5. The View menu lets you modify the appearance of iTunes 10.

 

In the early days, before Wally became an Internationally renowned comedian, computer book writer, and 
generally cool guy, Wally Wang used to hang around The Byte Buyer dangling participles with Jack 
Dunning and go to the gym to pump iron with Dan Gookin.  
 
Wally is responsible for the following books: 
 
Microsoft Office 2010 for Dummies (www.amazon.com/gp/product/0470489987?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470489987), 
Beginning Programming for Dummies (www.amazon.com/gp/product/0470088702?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470088702), 
Beginning Programming All-in-One Reference for Dummies (www.amazon.com/gp/product/0470108541?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0470108541), 
Breaking Into Acting for Dummies with Larry Garrison (www.amazon.com/gp/product/0764554468?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=0764554468),  
Steal This Computer Book 4.0 (www.amazon.com/gp/product/1593271050?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271050), 
My New Mac (www.amazon.com/gp/product/1593271646?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271646), 
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My New iPhone (www.amazon.com/gp/product/1593271956?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593271956), 
My New iPad (www.amazon.com/gp/product/1593272758?ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1593272758), 
Strategic Entrepreneurism with Jon Fisher and Gerald Fisher (www.amazon.com/gp/product/1590791894?
ie=UTF8&tag=the15minmovme-
20&linkCode=as2&camp=1789&creative=9325&creativeASIN=1590791894), 
How to Live With a Cat (When You Really Don't Want To) (www.smashwords.com/books/view/18896).  
 
When not performing stand-up comedy or writing computer books, he likes to paper trade stocks with the 
video game Stock Reflex (www.plimus.com/jsp/download_trial.jsp?
contractId=1722712&referrer=wwang), using the techniques he learned from a professional Wall Street 
day trader. 
 
In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15 Minute 
Movie Method." (www.15minutemoviemethod.com/) Wally can be reached at wally@computoredge.com.
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Rob, The ComputorTutor: 
Technology Solutions
“OpenOffice.org Word Processing” by Rob 
Spahitz 
 

Last week we started exploring a free 
competitor to Microsoft Office: OpenOffice 
(OpenOffice.org) and installed it. This week 
we'll start looking at its included word 
processor.

 
 
Last week we started exploring a free competitor to Microsoft Office, OpenOffice (OpenOffice.org), and 
installed it. This week we'll start looking at the word processor. 
 
Remember that I've never used this product before so I will offer my views from the perspective of a long-
time Microsoft (MS) Office user (although I've also used WordPerfect and others). 
 
Writer 
 
When you install OpenOffice, as with many other application suites, a collection of parts are made 
available from your Start button. In this case, I see the ones that we talked about last week and will start 
exploring OpenOffice.org Writer. 
 
When Write first starts, you are presented with a dialog box, as seen in Figure 1, which offers ways to 
assist the developers with improving the product. 
 

 
Figure 1. OpenOffice Improvement Process.

 
 
This may be a nice feature, but I wish they would explain more about how this improvement program 
works. Since I'm sure it sends things across the Internet, and my shared connection tends to run slowly, I'll 
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skip this. 
 
After this, you get into word processing mode, as seen in Figure 2. 
 

 
Figure 2. Writer Blank Document.

 
 
Initially, this looks very much like MS Word and other word processors. One notable difference from 
Word is that you see a border on the document, apparently representing the margins. You also see marks 
on the top rule to represent tab stops. If not set in Word, the defaults are every 1/2 inch, and here in Writer 
we actually see them (although they seem to be slightly less than 1/2 inch). Other than that, the menus are 
virtually identical to Word 2003 (except that Table and Tools are reversed), and the toolbars look a bit 
more cartoonish. 
 
Digging through the menus, you see some slight differences, so let me present them one at a time. 
 
File Menu 
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Figure 3. Writer File Menu.

 
 
Figure 3 shows the File menu. The real standout here is the Wizards item, but also that the New item has a 
flyout menu that offers other options. 
 
Looking at the New submenu, we see something interesting. Not only can you create a new word 
processing (text) document, but you also have access to the other items in the product suite, such as 
spreadsheets. 
 
One thing I noticed last week as I wrote the article is that multiple documents stack into the "master" 
container (something called an MDI: Multiple Document Interface). Word does this; Excel does this. 
Apparently OpenOffice does this across applications. This seems like a nice feature, but I wonder if I'll 
accidentally close the master thinking that I'm closing Writer but keeping a spreadsheet open, but that will 
close too because of this structure. We'll see. 
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In addition, it lets you create an HTML (Web page) document, and things like labels and business cards 
that I previously presented with MS Word. In a future article, we'll explore some of these. 
 
If you select Open, you get the expected Windows dialog box to let you select a document to open. Under 
Wizards, you can walk through the steps to create a Letter, Fax (are these still used?), Agenda, 
Presentation, or Web Page, plus there's something called Document Converter, Euro Converter and 
Address Data Source. Again, we'll explore these in the future. 
 
After this are some items that look obvious, such as Close and Save. Since these seem pretty obvious, I'll 
skip these and only report if there is anything unexpected. 
 
Next down, we see Export. Apparently this has a built-in translator to create a PDF (Portable Document 
Format) file, which is a generic format used to create a document that looks the same on every machine, 
even if the original tool used to create the document (such as Writer) and fonts are not available on that 
machine. Originally Adobe Corporation pushed for this, but over the years other variations were created 
that did not require licensing from Adobe. Anyway, this is a welcome feature since it is not built into MS 
Word, but requires a special plug-in or separate printer piece in Window. Anyway, the Export currently 
offers just that one option, so I expect in the future that additional export options can be added. There is 
also an option for Export as PDF, which lets you apply various PDF settings, such as a password and file-
size reduction. 
 
Next we see Send, which lets you direct the document to e-mail, apparently as an attachment to your 
default e-mail program. There are also some other options such as sending the document to a Web page, 
which apparently just saves the document as an HTML file. 
 
Next are a few miscellaneous features. Properties lets you set things about the document that are not part of 
the content; Digital Signatures is a way to help identify the creator of the document and show that the 
content was not tampered with; Templates lets us manage template files or save this as a template (which 
we'll explore another time); and you can preview the document or print it in ways that you would expect. 
 
Edit Menu 
 
This contains a lot of things you would expect. There's an option to Undo your last few keystrokes, Restore 
them after a mistaken undo, and a Repeat feature to re-type something (which sounds interesting, but not 
be so useful since you have copy-paste). You then get the usual Cut, Copy and Paste options plus a Paste 
Special, which lets you paste with additional settings if appropriate. 
 
Next comes something called Selection mode. When you look at its submenu you see Standard and Block 
Area. Really? This is so cool, if it's what I think it is. Sometimes you copy a lot of text from somewhere 
that has columns of information separated by spaces. When you try to copy just one column, it selects 
everything from the first letter you select, across to the end of the line, down the next line and continues 
selecting everything down to where you end. I'm hoping that Block Area lets you select a column such as 
the above without all of the parts left or right of the column. Of course, this can get tricky with 
proportional fonts, so we'll see what happens when I try that out in a future article. 
 
This menu group also lets you track changes to the document, which is great if the editing is shared 
between people (such as a writer of a story and an editor who marks areas that need to be changed). 
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There's also a Find & Replace, which works as expected, and a few other features, many of which are 
currently dimmed so I cannot see what they offer. I'm sure that they are just out of context right now with 
items such as Object that apply only when an embedded objected in the document is selected. 
 
View Menu 
 

 
Figure 4. View Menu.

 
 
This menu, seen above in Figure 4, also has many expected features. You get different layouts so you can 
see how the document will appear when printed or when viewed in a Web page. You can also work with 
toolbars, which seems like it will be just like toolbars in MS Word. You can show or hide rulers and text 
boundaries (the margins box I referred to at the beginning of the document). 
 
Next are some features related to Fields. These will be more useful when we make our document look like 
a page set up to act like an input form. 
 
You can also view non-printable characters, such as a marker to show the end of a paragraph, tabs and 
spaces. 
 
There are also a few other things like Data Sources and Navigator that will require more investigation in 
the future. 
 
Insert Menu 
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Figure 5. Insert Menu

 
 
This menu has many interesting features, as seen in Figure 5. The first few represent special characters or 
functions such as a page break or a copyright symbol. 
 
Further down you can add a Header or Footer section to the pages, along with bookmarks and hidden 
comments. Scripts is something I'll have to look into since when you pick it there is a reference to 
JavaScript, which is a programming language. 
 
Continuing you see Envelope, which opens a little wizard window to help set up the document for an 
envelope with a return address and a recipient. This looks interesting and we'll examine that at a later time. 
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With Frame, you can set up boxed areas on the document. At this point, I assume that it's like adding a 
"sticky note" to a page. This is similar to adding a text box into Word, but seems a bit more flexible. 
 
Looking at the rest of the items, they seem to refer to various types of objects that help make the document 
work like an input form. 
 
Other Menus 
 
The Format menu, as expected, contains features related to formatting your text. You can format individual 
characters, paragraphs (indents, etc.), the page (such as a background or headers and footers) and various 
other things like changing text case, working with columns, and how to work with text interacting with 
various objects. For example, you can have text wrap around a picture or on top of it. 
 
The Table menu handles things related to tables, including adding rows, columns and formulas to cells. 
 
The Tools menu offers things like Spell-check and Grammar check, Word Count, a Mail Merge and 
Macros. Since I'm a programmer at heart, you know I'll be checking into the Macros to see how we can add 
features that might be missing. 
 
The Windows menu shows the current documents that are open so you can switch between them. Since we 
seem to be able to add spreadsheets and other things, I'm guessing that this will list all OpenOffice 
documents and not just the word processing documents. We'll see. 
 
Finally, the Help menu offers standard-looking help plus the ability to check for the latest updates. 
 
Summary 
 
All in all, so far I'm very impressed. It appears that the creators of OpenOffice looked at all of the most 
used features from other word processors and included them and, in some cases, made them look or act a 
bit better. 
 
Next time I'll start creating a more complex document to see if it handles everything I need. Until then, 
send your thoughts if you have used Writer or are just starting out with this free-for-use product. 
 

Rob has been in the computer industry for over 25 years and is currently a part-time teacher, offering 
classes in Excel, Access, Visual Basic, and a variety of other technical tools. He has loved ComputorEdge 
since 1990 and can be contacted at RSpahitz@Dogopoly.com. 
 
Looking for a great boardgame? Grab a copy from DOGOPOLY.com (dogopoly.com) and 
have a dog-gone great time.
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Protect Your Children from Online Predators and Cyberbullies 
 
Iconosys (www.iconosys.com) CEO and founder Wayne Irving II says his company will soon be unveiling 
an app that allows parents to better monitor the whereabouts of their children and can also weed out texts 
or phone calls from cyber predators. In the meantime, Irving—himself a father of four—offers the 
following safety tips for parents: 
 
1) Set family guidelines for Internet/phone use (have an organized meeting, if necessary). 
 
2) Educate children about the risks, legalities and repercussions of online activities. 
 
3) Remind children that it is not OK to give personal information to anyone you don't trust. 
 
4) Let them know that it is highly dangerous if they open or read messages from people they do not know; 
ignore them or show them to mom or dad. 
 
5) E-mails and text messages promising "the sky" should not be taken seriously and kids should know that 
they are a potential signal from someone who wants to put a virus on their PC or phone and make it break 
and never work again. 
 
6) Let them know it is OK to ignore/block/delete anyone who makes you feel weird or uncomfortable. 
 
7) Regularly change your child's e-mail/username/cell phone number/account information/passwords (at 
least until they are of college age). 
 
8) Let children know that it is OK to talk to you about contact from someone they may have thought they 
trusted and realize they now don't. If not you, who in the family are they comfortable to discuss this with? 
 
9) Install a product on your child's phone (like the upcoming one from Iconosys) so you can more closely 
monitor your child's safety. 
 
Smarter Food Purchases—In Real Time 
 
As smartphone adoption continues to increase, people expect mobile devices to improve their everyday 
lives—right down to making smart decisions about food, according to the newest study by research 

ComputorEdge 9/10/10

33 of 42



consultancy group Latitude (www.latd.com) titled "The Interactive Future of Food." 
 
The study, designed by senior analyst Marina Miloslavsky, collected and analyzed data from participants 
across the world who shared personal narratives about a time they needed more information while grocery 
shopping. Participants were then asked to imagine new or existing technology solutions that they felt 
would best address their needs. 
 
According to the group, "The goal of the study was to learn how technology could be applied in innovative 
ways to help people access food information at the moment of purchase—to assist good decision-making 
and to create a more intelligent store experience. More than half (56 percent) of study participants 
expressed a need for more product information such as health, food origins, organic vs. non-organic, 
farming practices, food safety or ingredient details, while 31 percent requested information that was 
logistical in nature, such as location in store, price and inventory status." 
 
"We found that people want to make better decisions and, regardless of age and technology adoption, now 
inherently expect mobile technology to help them do so," explains Neela Sakaria, vice president of 
Latitude. "This now-mainstream desire to access relevant information at the exact moment it matters most 
has far-ranging implications for brands and retailers—implications which they've only just begun to 
explore." 
 
"The study findings suggest that improved information access via mobile solutions can have a significant 
impact on offline purchasing decisions—which means that retailers can profit by providing customers with 
in-store tools to retrieve additional product information," notes Latitude. "People want to make healthy, 
environmentally conscious choices and new technology solutions can help by improving the way we shop 
for food, the way it gets delivered and ultimately, the way it is produced and distributed. 
 
"Study participants intuitively understood how real-time technology can improve purchasing decisions, 
which presents a growing opportunity for both retailers and brands to build positive relationships with 
customers. But it also means marketers should be wary of trying to 'pull one over' on people," adds 
Sakaria. "Thanks to mobile, people will be bringing to bear not only everything they've heard about your 
brand before walking into the store, but also everything that's possible to learn on the Web while standing 
right in front of your product in the grocery aisle. If retailers and brands don't jump in and actively provide 
customers with that information, they'll inevitably find it elsewhere." 
 
More info by downloading at Life Connected (www.life-connected.com/cms/wp-content/uploads/2010/04/
The-Interactive-Future-of-Food-Latitude-Research.pdf) . 
 
When Cloning Does Only Half the Job 
 
I've been recently joking that my last hard drive crashed so hard I lost changes I'd made to my beard two 
weeks before. 
 
For many of us, cloning (the process through which one makes a copy of the hard drive so perfect the drive 
will boot Windows) has been the magic bullet that protects us from what is perhaps the weakest link in the 
data chain: mechanical hard drives. 
 
Usually, cloning is all you need. Your drive crashes and you boot from the last clone (done, ideally, less 
than a month before). Then you connect the bad drive as an external USB drive and simply copy over the 
relatively few files that have changed since you made the clone. Good as new ... right? 
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But what if the drive crashes so badly it can't be read as an external drive? Sure, the vast majority of your 
files were backed up in the cloning process, but what if you've put a significant amount of time into work 
created or edited since the clone? 
 
That's what happened to me. Even though it had only been a month since my last clone, I lost nearly 100 
hours of work on a new stage play, hundreds of edits on a short film, at least a dozen articles, pictures of 
my families' summer vacation, and ... you get the idea. Oblivion. Oh, yea, I forgot. I lost a bunch of my 
Oblivion game saves, too! 
 
The idea of doing all that work over again is enough to make one physically ill.  
 
There are undoubtedly others, but I found two products that filled the holes in my data backup regimen. 
 
The first, EASEUS Data Recovery Wizard, was able to find and restore every one of my lost files. The 
process is actually pretty interesting. My damaged 1TB drive churned away for almost an entire day before 
IDrive proffered a list of thousands of alphabetically arranged folders. It requires a little detective work to 
find the files you want restored because Windows often puts them in the most delightfully unexpected 
places. 
 

 
Figure 1. EASEUS Data Recovery Wizard.

 
 
The free version allows 1GB of file recovery. Thereafter, they ask $69.95 or $89.95 (pro version) for 
unlimited recovery. 
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EASUS will recover files that have been emptied from the Recycle Bin, or from accidentally formatted 
hard drives; or as the result of software crashes, virus attacks, or lost partitions. I shudder to think how 
much time it would have taken to recreate all that stuff. 
 
To drastically minimize risk between clonings, I installed the second program, IDrive (www.idrive.com). 
 
IDrive offers 2GB of online data storage for free. Simply tag individual files or entire directories and 
iDrive stores them on its own servers for quick and easy recovery. 
 

 
Figure 2. iDrive.

 
 
After the 2GB limit, a personal use account (up to 150GB of data) costs $4.95/month. There's also a family 
account (up to 500GB) for $14.95/month and a business account (up to 50GB) for $9.95/month. 
 
So far, cheapskate that I am, I've been able to stay well under the 2GB free limit by tagging just the files on 
which I'm currently working. The program resides in the System Tray and can be automatically set to 
backup at the same time every day, week, or month.  
 
Of course, IDrive doesn't care because it believes it's just a matter of time until my list of tagged files 
creeps up to more than the 2GB limit (I'll prove them wrong!). Still, even if that day comes, what a 
ridiculously small price to pay for the peace of mind it offers. 
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The key with any program like IDrive is to make sure you TAG THOSE FILES. If you start the great 
American novel a week after cloning but are remiss to let IDrive in on your little secret and the worst 
happens, well, you're out of luck. Also, if you pull an all-nighter on your college term paper BETWEEN 
daily backups and data disaster strikes ... uh oh. That's why IDrive has a "Backup Now" option to be 
implemented before every bathroom or pizza break. 
 

 each for EASEUS Data Recovery Wizard and IDrive.
 

In addition to being an editor and columnist for ComputorEdge and ComputerScene Magazines, where he 
has written hundreds of feature articles and cover stories over the past decade, Charles Carr has also 
penned well over 1,000 non-tech newspaper and magazine articles and columns for various publications, 
including two widely-read columns each week for San Diego's North County Times newspaper. 
 
Carr has covered such diverse topics as pesticide use in area schools, invasive background checks for 
county volunteers, asthma awareness, the debate over standards-based grading, potential vulnerabilities in 
electronic voting machines, and Southern California's devastating 2003 and 2007 wildfires. He has also 
written many humorous pieces. 
 
Carr has also edited dozens of stories and articles written by others which have appeared in major 
publications and web sites across the country. 
 
He has been a contributor and technical advisor to L.A. and San Diego Parent magazines and receives 
dozens of requests a year to appear on Southern California television and radio stations to talk about 
important events in the tech world. 
 
Carr has judged many writing competitions including San Diego Press Club and Time-Warner 
Communications contests and was sole judge for the national NAPPA Tech Toys awards for five years 
(which his kids really appreciated). He was recently a judge for the national "Poetry Out Loud" 
competition. 
 
He has won many writing accolades, including Press Club awards for Best Column Writing, Consumer 
Writing and Best Arts and Entertainment, and has repeatedly taken top honors in San Diego Songwriter's 
Guild competitions for his original musical compositions. 
 
Carr will soon publish his first book, What a World, a collection of his best writings. 
 
Learn more at www.charlescarr.com. 
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EdgeWord: A Note from the Publisher
“Is 'Good Enough' Good Enough?” by Jack Dunning 
 

If Windows 7 is so good, why are so many people continuing 
with Windows XP? The answer is simple—XP is good 
enough. Also, musings on the iPad, Android and other issues.

 
 
As of next month, Dell will no longer ship computers with Windows XP installed. This is no surprise since 
the older operating system is not better than Windows 7, yet requires just as much (if not more) support. 
Dell will continue XP driver support until December 2012. Of course, if there is enough market demand, 
these dates could change as they have with Microsoft. 
 
If Windows 7 is so good, why are so many people continuing with Windows XP? The answer is simple—
XP is good enough. It was bound to happen that eventually a computer would be produced with enough 
power and reliability to kill the incentive to upgrade—at least for a huge number of people. Not only are 
many people satisfied with Windows XP, they have no desire to even incrementally encounter anything 
different. 
 
Some people may need Windows XP for legacy programs that won't run in Windows 7, but I would 
suggest that they are in the minority. In most cases, the programs will either run in Windows 7 or at a 
minimum with the Windows XP compatibility mode available in the Professional and above versions. It's 
actually a case of "If it ain't broke, don't fix it." 
 
One of the beauties of sticking with Windows XP is that a person doesn't need to experience what they are 
missing with Windows 7—if anything. 
 

*                    *                    *
 
Some are predicting that Apple will sell 28 million iPads in 2011. That's a lot of hardware. It appears that 
the low-end netbook computers are the most vulnerable to the success of the iPad. (I've always regarded 
netbooks a bit of a novelty since my fingers wouldn't fit on the keyboard.) 
 
To be honest, I would like to own an iPad. It has a reasonably low price (almost an impulse item for 
anyone with a job) and looks likes it could provide hours of amusement. I'm hoping that someone will give 
me one for Christmas. 
 

*                    *                    *
 
There are 100,000 apps for Android smartphones while there are 200,000 apps for Apple's iPhone. Apple 
would be clearly winning if it weren't for the fact that the vast majority of apps are garbage—I don't care 
what the platform is. A better comparison would be the number of apps available that people actually care 
about or use. My guess is that the numbers would not only be smaller, but much closer together. 
 

*                    *                    *
 
It appears that Verizon may be tossing the Google mobile search off of some of its Android phones in 
favor of Microsoft's Bing. This would not set well with Google since the primary reason for offering a free 
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operating system is to get access to those mobile searches. This may be short-lived if customers really do 
prefer Google over Bing. They just won't buy a smartphone without Google—although I don't know if 
anyone cares about which search engine they are using on their smartphone. 
 

*                    *                    *
 
Based upon the length of the typical cell phone contract, the life cycle of a cell phone is about two years. 
That means the manufacturers need to come out with something new and better every year. Otherwise they 
will find that they are suddenly out of the market. While one company may be on top today, it could be a 
totally different picture one year from now. Will it ever reach a point where the smartphone business has 
its own Windows XP—a smartphone that is just good enough that people won't bother to upgrade? While 
not likely, it would cause a huge shakeout in the cell phone hardware industry.
 

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first issue on May 16, 
1983. Back then, it was called The Byte Buyer. His Web site is www.computoredge.com. He can be reached 
at ceeditor@computoredge.com
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Editor's Letters: Tips and Thoughts 
from Readers
“Computer and Internet tips, plus comments on the 
articles and columns.” by ComputorEdge Staff 
 

"Android in Your Future?"; "Sandy's Slow Computer," "File 
Date Problem," "John's Windows 7 Problems," "You Left the 
Smartest Phone Out"

 
 
Android in Your Future? 
 
[Regarding James Hartnett's August 27 article, "Is There an Android in Your Future?":] 
 
Android in your business? I wonder how free Android is. You have a GPS on your phone and Google can 
track everywhere you go, every store you enter, every restaurant you eat at. You may think that is 
unethical, but have you read the fine print in your phone agreement? I hope I am only being paranoid, but I 
will resist the "free" ploy because nothing is free. 
 
-Marcus, Alabama 
 
Sandy's Slow Computer 
 
[Regarding the August 27 Digital Dave column:] 
 
Sandy mentioned that her slow computer was only slow for the first hour or so, after starting. She also 
mentioned that AVG is "running," as seen in her Task Manager. Just wondering if AVG is actually 
scanning that first hour or so? A quick check in AVG's preferences, etc., should tell her if she has a scan 
programmed every time she starts the computer.  
 
Good luck, Sandy. 
 
-Jerry Hughes, San Diego, CA 
 
I switched to free virus protection and went with AVG. Sure enough, my computer crawled. I deleted, 
installed Panda and it was fast again. As Panda was not picking up everything—trouble on two computers 
and total rebuilds—I switched over to Avast and it is working great. AVG was horrible on speed. 
 
-Vic (Garcia), Monument, CO 
 
I also have found that AVG runs incredibly slow; I recommend using Avast instead. 
 
-Javier Sandoval, Juarez Chihuahua Mexico 
 
Thank you Dave and others for the tips. I do use CCleaner, and will try the other advice now that I am back 
in town. 
 
-Sandy, San Diego 
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File Date Problem 
 
[Regarding the August 27 Digital Dave column:] 
 
The /TIMFIX switch is no longer supported in Robocopy, but the same effect is obtained by simply using 
the /T switch. In fact if you wanted all the attributes and characteristics of the original files to be 
"transported'' to the new location, simply use the /COPY:DATSOU (for all the switches) or the shortcut /
COPYALL, which is the identical substitute directive. 
 
-Tim Hood, San Diego 
 
Question about keeping file dates: I prefix many of my files with this example "2010_10_27 file name". 
Easy to sort files. Doesn't matter what the system does to the date. 
 
-Wm Tiep, Toledo, OH 
 
John's Windows 7 Problems 
 
[Regarding the August 27 Digital Dave column:] 
 
I had similar problems with older software. Instead of using the "autoload" feature on most discs, I went 
right to the .exe file and loaded it from there. I did get twi of three programs to load this way. It is worth a 
try. 
 
-John Mlcoch, Highlands Ranch, CO 
 
OK, first of all, back up all of your files and then do a system restore. 
 
If this works, then go to Start. Click on Maintenance and make a restore disc for future problems like this. 
If the system restore does not work, then do a complete reinstall and then make the system restore disc 
before you do anything. I had this happen, and system restore is different from any other version of 
Windows ever. It does work. Oftentimes it is one of their own updates that are the cause of the problem or 
something you downloaded, or you went to a site that downloads a program to your computer. Set your 
computer to warn you if anything is being installed. You can nip it before you have a problem. 
 
-Melba Kalahe, Denver Co 
 
You Left the Smartest Phone Out 
 
[Regarding Wally Wang's August 27 article, "Smartphone Decisions":] 
 
You totally left out Palm webOS phones; this is by far the best mobile OS on the market and it continues to 
be overlooked. webOS has a large community following and we all sit back and shake our heads at the 
iSheep and Androids and wonder why no one does their own research anymore and simply follows the 
crowd. HP bought Palm because of the potential it saw in webOS. Take a look here (www.webosroundup.
com/) and here (www.precentral.net/) at what the webOS community is up to.. 
 
-Christopher Varney, Murrieta, CA 
 
Palm's (and now Hewlett-Packard's) webOS is actually a very good phone operating system. The problem 
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is simply the fumbling of Palm in launching the phone and getting much backing behind it. Palm had a 
huge lead in the PDA and smartphone market and let it slip away to almost nothing. Maybe HP can revive 
webOS and keep it thriving.  
 
The sad truth is that great technology doesn't always equal profitability or market share. If everyone chose 
personal computers based on technical capability, we should have all switched to the Commodore Amiga 
decades ago. webOS phones are at least equal to iPhone and Android phones, but until HP breathes some 
marketing life into webOS, it's hard to recommend webOS phones over the iPhone or Android phones for 
now. If you want a great selection of apps, the iPhone and Android phones completely overwhelm the 
choices of apps for webOS. 
 
-Wally Wang 
 

ComputorEdge always wants to hear from you, our readers. If you have specific comments about one of 
our articles, please click the "Tell us what you think about this article!" link at the top or bottom of the 
article/column. Your comments will be attached to the column and may appear at a later time in the 
"Editor's Letters" section. 
 
If you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at 
ceeditor@computoredge.com.
 

 
Send mail to ceeditor@computoredge.com with questions about editorial content. 

Send mail to cewebmaster@computoredge.com with questions or comments about this Web site. 
Copyright © 1997-2010 The Byte Buyer, Inc. 
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